The CACM Digital Fabrication Lab 3D printer farm is accessible to all CACM students. The following guide will provide the steps necessary for downloading and setting up Cura software for your personal computer, as well as instructions for how to “slice” a model in Cura and submit it to a printer.

*Note: Students can also access Cura in the Student Success Headquarters (SSHQ) and 11 computer labs.*

**3D Printing Farm Policy**
1) $15/1000g filament limit per student per semester
2) Prints start on first come, first serve basis within the queue
3) Each student may queue up to 1 job at a time
4) Only CACM class projects are permitted, no personal printing is available

**Table of Contents**
1) [Cura Software Setup (Windows)](#)
2) [Cura Software Setup (MacOS)](#)
3) [Cura Software Tour](#)
4) [3D Printing Crash Course](#)
5) [Slicing a File for 3D Printing](#)
6) [Submitting a Sliced File to 3DPrinterOS](#)
Chapter 1
Cura Software Setup (Windows)
This chapter covers how to install and setup Ultimaker Cura for your own personal laptop (Windows).

Cura is already installed and setup in all CACM labs.

Download and launch Ultimaker Cura:

https://ultimaker.com/software/ultimaker-cura
User Agreement

Disclaimer by Ultimaker

Please read this disclaimer carefully.

Except when otherwise stated in writing, Ultimaker provides any Ultimaker software or third party software “As is” without warranty of any kind. The entire risk as to the quality and performance of Ultimaker software is with you.

Unless required by applicable law or agreed to in writing, in no event will Ultimaker be liable to you for damages, including any general, special, incidental, or consequential damages arising out of the use or inability to use any Ultimaker software or third party software.

Click through and agree to any pop-ups you get upon launch...
...when you are asked to sign in to Ultimaker however, just click "Skip".

You don’t need an account.
Cura forces us to add a printer before we can proceed, so we're going to add a random printer in the meantime.

Click “Add a non-networked printer”...
It doesn't matter what printer is selected here because we are about to overwrite this setting.

...and just click “Next” to continue.
More prompts! “Skip” through anything else that pops up here.
Once you’re finally at the main page, click “Help” in the menu bar. Then, click “Show Configuration Folder”.
The following configuration folder should pop-up.

Close Cura now, but keep this new folder open.
Select all files within this folder and delete them.
If you see the following pop-up, you still have Cura open :(

Make sure Cura is closed and try to delete again, otherwise the next steps won't work.
Keep your newly emptied configuration folder open (right).

Open the “Cura Profile Settings” folder, downloaded from the lab website (left).

There will be a folder called “Windows Config Files” inside. Open this.
Copy-paste OR drag all files inside "Windows Config Files" into the empty configuration folder.

This will overwrite Cura's settings and add all profiles automatically.
After moving the files into the configuration folder, close the folders and re-open Cura.
Cura should now open up with all of our printer farm profiles installed.

If you get a firmware or beta pop-up at the bottom, just ignore it and X out of the window.
To confirm that your Cura is now setup correctly, click on the bar at the top and confirm that the following preset printers are listed:

- Creality CR-20 Pro
- Ultimaker S3
- Ultimaker S5
Cura is now setup on your personal computer.

You do not need to repeat these setup steps again, however it is recommended to update your program and refresh the configuration files once a semester.
Chapter 2
Cura Software Setup (MacOS)
Welcome to Ultimaker Cura

Please follow these steps to set up Ultimaker Cura. This will only take a few moments.

Get started
User Agreement

Disclaimer by Ultimaker

Please read this disclaimer carefully.

Except when otherwise stated in writing, Ultimaker provides any Ultimaker software or third party software "As is" without warranty of any kind. The entire risk as to the quality and performance of Ultimaker software is with you.

Unless required by applicable law or agreed to in writing, in no event will Ultimaker be liable to you for damages, including any general, special, incidental, or consequential damages arising out of the use or inability to use any Ultimaker software or third party software.

Click through and agree to any pop-ups you get upon launch...
...when you are asked to sign in to Ultimaker however, just click "Skip".
You don’t need an account.

- Add material settings and plugins from the Marketplace
- Backup and sync your material settings and plugins
- Share ideas and get help from 48,000+ users in the Ultimaker Community
Help us to improve Ultimaker Cura

Ultimaker Cura collects anonymous data to improve print quality and user experience, including:

- Machine types
- Material usage
- Number of slices
- Print settings

Data collected by Ultimaker Cura will not contain any personal information.

More information
At the “Add a Printer” window, you will not be able to click “Next”.

Cura forces us to add a printer before we can proceed, so we're going to add a random printer in the meantime.

Click “Add a non-networked printer”...
...and just click “Next” to continue.

It doesn’t matter what printer is selected here because we are about to overwrite this setting.
More prompts! “Skip” or “Next” through anything else that pops up here.

All-new slicing engine

Following special beta releases to test the Arachne engine, we are pleased to announce our new slicing engine is here in Ultimaker Cura! This all-new engine uses variable line widths when preparing files for printing, meaning you can now print thin and intricate parts more accurately and with greater strength. Watch the launch event to learn more.
Once you're finally at the main page, click "Help" in the menu bar.

Then, click "Show Configuration Folder".
The following configuration folder should pop-up.

Close Cura now (do not minimize), but keep this new folder open.
Select all files within this folder and delete them.
The configuration folder should now be clear of all files.
Keep your newly emptied configuration folder open (back right).

Open the “Cura Profile Settings” folder, downloaded from the lab website (front left).

There will be a folder called “MacOS Config Files”. Open this.
Copy-paste OR drag all files inside “MacOS Config Files” into the empty configuration folder.

This will overwrite Cura’s settings and add all profiles automatically.
After moving the files into the configuration folder, close the folders and re-open Cura.
Cura should now open up with all of our printer farm profiles installed.

If you get a firmware or beta pop-up at the bottom, just ignore it and X out of the window.
To confirm that your Cura is now setup correctly, click on the bar at the top and confirm that the following preset printers are listed:

- Creality CR-20 Pro
- Ultimaker S3
- Ultimaker S5
Cura is now setup on your personal computer.

You do not need to repeat these setup steps again, however it is recommended to update your program and refresh the configuration files once a semester.
Chapter 3
Cura Software Tour
Let's take a quick tour of Cura and of our different machines before slicing our first file.

To swap between printer types, click the bar at the top-left.

Now click “Creality CR-20 Pro”.
With Creality CR-20 Pro now selected, let's look at the different profiles for the machine.

First, click the bar at the top to open the “Print settings” window at the right...
...now click the drop-down arrow to open up the default profiles list.

Notice the 3 Arch315 profiles for this machine. When you slice your files, you will always use one of these profiles to start with.

The higher the quality of the profile you select, the longer the print will take to complete.
Now let's look at the Ultimaker S3 settings.

Change your printer to Ultimaker S3.
Notice how the printer bed in the viewport changes with the different printer selected.

Now let's look at the settings by clicking the settings bar above.
Open up the default profiles drop-down arrow again and review the Ult S3’s custom profiles.

(You may need to scroll to see them.)
Now change to Ultimaker S5.
The size of the bed has increased, since the S5 is larger than the S3.

Now click the bar to open the settings.
Like before, open “Profiles” and view the Arch315 profiles listed.

No matter which machine you use, you should ALWAYS select one of the “Arch315” custom profiles for your settings.

Selecting the other default profiles may compromise your print.
Note that the S5 machines print on a larger bed and use SOLUBLE SUPPORT rather than breakaway support.

We will touch on this key difference later.
The next chapter will review basic 3D printing functions and parameters.

A general understanding of the printers will help you setup your first file successfully.
FDM 3D printers squeeze plastic filament through a hot nozzle, melt it, and then deposit it in thin layers onto the printer bed. These layers build up and fuse together to form the final object.

*The thinner these layers are, the “finer” the resolution of the object, but the longer the job takes.*
Models that have overhangs or bridges, however, face a dilemma:

How can material be dropped into thin air in order to build up an overhanging ledge?
“Support material” must be generated in the printing process to account for gravity, which will “catch” the overhanging structures when they print.

As long as an Arch315 profile is used, support material will be calculated automatically.
Not all overhangs need support: mild ledges, such as the “Y” in the example, may not generate any.
Notice how the “T” looks when the support is turned OFF though.

There was nothing to hold up the first few layers of filament during the printing process, so the bottom appears frayed as the first layers of material were dropped “mid-air”.

without support  with support
The breakaway support structures offer the fastest printing times and can be removed easily by hand after printing.

The Creality CR-20 and Ultimaker S3 printers print with breakaway support.
Keep in mind that support structures may be a constant in how your design is 3D printed.

For example, let’s try to prepare this simple house model for 3D printing in Cura. This structure was modeled in Rhino.
This example was processed using the Creality CR-20 with a “Standard” Arch315 profile.

The red and yellow parts of the model indicate the permanent model structure.

The light blue indicates support material generated by Cura.
Notice how support must be generated under the roof overhang.

You cannot see it in this image, but the entire interior of the house is also encased with support material to print the roof on the inside!
Not only will this support be impossible to remove from the inside through the tiny house window, but the excess materials used to print all of the support make for a long print time.
Turning the house upside-down in Cura saves some material cost and time, since there is less support needed for the roof exterior.

However the house still has support trapped inside which will make this model unintentionally “solid”.

Object list:
- CCR20PRO_house1_full

Dimensions: 66.1 x 49.6 x 87.8 mm

Estimated time: 11 hours 30 minutes

Estimated weight: 88g

Cost: $1.32

Save to Removable Drive
The easiest solution is to remove the roof in Rhino and print the source of the overhang separately.

The only support generated is in the window, which can be easily punched out by hand.

See how much time this also saves?

- 5 hours 48 minutes
- 44g 14.62/m $0.65

Save to Removable Drive
These parts are PLA plastic, and if needed, can be easily conjoined with any standard CA glue or superglue.
There may be designs that are too complex, however, to “split apart” in a practical way to make support removal easier.

This is where the Ultimaker S5 (the larger machine) may come into play.
For this next example, let's take a look at what the breakaway support will look like across different models in Cura.

Notice the varying levels of complexity in these chess pieces...
When we flip the viewport to look underneath, the red highlights indicate where support may be generated for our current Arch315 settings.

Let’s see what the breakaway support will look like once generated...
While our 1st does not need support at all, the 2nd piece generates a ring of removable support around the object in order to print the first layers of the overhang.
The 3rd is more complex, however, and generates support both inside and outside of the voronoi structure.

Can you guess why this particular design might be an issue for us later?
Here’s the answer:

The majority of the support structure in the 3rd chess piece cannot be removed, since it’s trapped inside of the design with no way to clip it out.

AKA... it’s stuck!
This is where “soluble support” on the Ultimaker S5 comes into play!

If we queue up the design to an S5 machine the support that is generated will be printed with a special dissolvable filament type.
Once finished printing, place the piece into a cup of water for a couple of hours *(time will vary depending on size)*.

The PVA support material is dissolved away and leaves the object behind!
The final result is not the prettiest and will require some mild clean-up work, however at least compared to the chess piece on the left, the right object is usable.

breakaway support :(  
water soluble support
Let’s go back to the house example and look at it with soluble support now.

While we could slice the entire house on the S5 using soluble supports, we’re only slowing ourselves down.

The house would still print best with the roof removed.
Printing with soluble supports is a slower and more expensive process in general, however may be necessary for complex objects.

Don’t forget that you must also budget for additional time to dissolve the support filament away after the printing process.
In summary, a break-down chart of all the equipment will be provided on the next page.

*All machines print at the same quality.*

Staff asks that students *only* utilize the larger-format S5 machines for 3D prints that CANNOT be cut down to size OR sliced easily for breakaway support.
Creality CR-20 Pro
- (220 x 220 x 250mm)
  (8.6 x 8.6 x 9.8in)
- PLA plastic filament (white or black)
- Breakaway support (hand-removal)

Ultimaker S3
- (230 x 190 x 200mm)
  (9.0 x 7.4 x 7.8in)
- PLA plastic filament (white only)
- Breakaway support (hand-removal)

Ultimaker S5
- (330 x 240 x 300mm)
  (13.0 x 9.4 x 11.8in)
- PLA plastic filament (white only)
- Soluble support (dissolve in water)
Chapter 5
Slicing a File for 3D Printing
Let’s “slice” (process) our first 3D file in Cura.

*All models must be sliced in Cura before uploading to a 3D printer.*

Make sure the “Prepare” tab is selected. This window is where we setup all 3D models on the bed of the 3D printer.
Cura is LOCKED to work in millimeters, so convert all models to millimeters first in the native program.

Export out an .STL file(s).

If there are multiple separate objects, make a different STL file for each separate object.
To add .STL files to Cura, drag-and-drop them into the viewport, or click “File > Open File(s)...”
If the objects import in VERY small, then the native units were NOT in millimeters.

This example was exported out of Rhino in inches.

What was intended to be a 3” tall object is now 3mm tall instead :(
For more information, you can see the size that the objects imported in at the bottom left corner.

Note that this is the combined size of ALL objects together on the plate, including the space in-between.
The fix the scale, the easiest thing to do is to re-export out the .STLs in millimeters.

However, in this example I know that the example objects were accidentally exported in inches, so I can also “convert” them manually in Cura.

Click “Edit > Select All Models”.
All objects are now selected and show at the bottom left “Object list”.

The left toolbar is also now active, which lets us move, rotate, and scale the selected objects.

Click the 2nd icon for “Scale”.

Click the 2nd icon for “Scale”.

Click the 2nd icon for “Scale”.

Click the 2nd icon for “Scale”.

Click the 2nd icon for “Scale”.
With “Uniform Scaling” checked on, scale the objects to 2540% to “convert” from inches to millimeters.

ALWAYS double check the sizing at the bottom left when making scale adjustments in Cura.
After confirming the scale, the objects have been re-arranged to not overlap.

There is also a command to help arrange all objects automatically.

Notice the other commands in the “Edit” menu to duplicate, reset positions, and more for further manipulation of your models.
These objects are now scaled, oriented optimally in the center of the plate, and are ready for slicing.

Open the “Print settings” menu by clicking the bar at the right.
Always start by selecting a custom “Arch 315” profile from the drop-down list when slicing.

Let’s start with selecting the “High Quality” custom profile.
The “High Quality” profile slices at our smallest layer height.

Once the profile is selected, slice the model for preview by clicking “Slice”.

On the proröle, slice the model for preview by clicking “Slice”.

The “High Quality” profile slices at our smallest layer height.

Once the profile is selected, slice the model for preview by clicking “Slice”.

On the proröle, slice the model for preview by clicking “Slice”.
After slicing, the material usage and estimated printing time is calculated at the bottom right. At an estimated 14 hours, the “High Quality” profile is excessive for the simplicity of this design.
“High Quality” works best for files that have very fine surface detail and textures, such as filigree.

Not all details may retain their structural integrity when printed in miniature and printed thin (i.e., handrails, doorknobs, stairs are common culprits).
Let’s try the “Low Quality” option now.
Click “Slice” again after.
After selecting a new profile or making any other change to the models, the program must slice again.
Notice how much time is saved on the “Low Quality” profile.

For most designs, the “Low Quality” option will be the most optimal and efficient.
Also please NOTE:

These are ESTIMATED TIMES and may not reflect the actual length of time it will take for the object to print.

Please always allot additional time for fabrication and to account for potential machine error.
After slicing, the most important step in the entire process is to review the slicing before exporting.

Never assume that the models in the “Prepare” window will look as intended when sliced.

Click either “Preview” button.
The preview window shows the individual sliced layers of the STL files.

For a better idea what the different highlighted colors mean, click the middle toolbar “Color Scheme” and zoom in on the objects.
The pop-out “Color scheme” can be toggled for visibility. The slider at the right can also be dragged to scrub through each sliced layer of the object.

The light blue “ Helpers” channel highlights the support material and the build-adhesion material, both of which can be removed after printing.
If there are any abnormalities with the previewed object, then there may be issues with the mesh that was exported from the native program.

<Meshes cannot be fixed in Cura>, so the best option is to return to the native program to address any issues, and then try again.
Lastly...

It is not recommended to tweak the individual printer values in any profile, however LARGE, BLOCKY, SOLID objects can be reduced to 5% “infill density” to decrease time/cost.
Chapter 6
Submitting a Sliced File to 3DPrinterOS
After slicing, previewing, and confirming the STL files are setup optimally in Cura, it is time to save the .GCODE file and upload it to a printer using 3DPrinterOS.

Click “Save to Disk”.
If “Save to Disk” is not there, click the drop-down arrow to swap to it, then click “Save to Disk” again.
The “Save to Disk” window will pop-up.

Note: This process is the same for Mac users but may look slightly different.

Make sure that the filetype selected is "gcode". Change to "gcode" if another filetype is set.
Click “Save” to save the .gcode file to the PC.
The file has now been saved, and can be easily accessed by clicking the “Open Folder” button below.

Have the exported .gcode file on standby for uploading.
Sliced files are uploaded through 3DPrinterOS.

CACM students that have been granted access to the printer farm will receive a registration email similar to the example at the right.

Welcome to 3DPrinterOS!

Dear [Name],

Your account has been successfully created! Password for your account is: RNEGnb3RwXjLtztqNhMN

Why do you need password?
To access versions of files you sliced and printed, statistics, printing history, printer settings. Also to be able to use printers connected to Raspberry Pi with products that use our API.

Regards,
3DPrinterOS Team.
Copy the auto-generated password from YOUR account registration email.

Be sure to not to accidentally highlight and copy the “space” at the end of the code, as this will count as an extra character in the password.

Welcome to 3DPrinterOS!

Dear [Name],

Your account has been successfully created.
Password for your account is: RNEGnb3xJLzgNhMN

Why do you need passwords?
To access versions of apps you sliced and printed, statistics, printing history, printer settings, and to be able to use printers connected to Raspberry Pi with products that use our API.

Regards,
3DPrinterOS Team.
Go to www.3dprinteros.com.
Favorite or bookmark this page.
Click the “Sign In” button at the top right.
Add your KSU email address in the “Email” field.

Paste the passcode, copied from the registration email, into the “Password” field.

Click “Sign in”.
After logging in, “Files” will open. All files that you upload for printing will store on this page.

By default, the files library will include pre-uploaded example models of rubber ducks, which can be deleted.
For easier access in the future, the password can be changed by clicking on your email at the top right to open up a drop-down menu, then clicking “Profile settings”.

You will find a “Change password” link on the new page.
To upload .gcode file(s) that you sliced in Cura, click the “Add files” button.
Drag-and-drop the .gcode into the box, or click “select from computer”. Multiple files can be uploaded at once.

Drag and drop to upload content!
After adding the .gcode, “Select Printer type” will appear.

For files that were sliced for the CR-20 Pro machines, use the default “Creality Ender 3” printer profile.

CR-20 is not an available profile on the website, so we use Ender-3 as a substitute.
For .gcode that was sliced for the Ultimaker S3 or S5, click the drop-down arrow and select either “Ultimaker S3” or “Ultimaker S5” under “My Printers”.

If the incorrect printer type is selected, than your object may not print successfully.
Once the proper machine is selected, click “Save”.
Once the object is fully uploaded, the “Preview” and “Print” options will appear.

It is recommended to always “preview” your uploaded object first to double-check your file prior to printing.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.

After confirming your file is correct, click “Print”.
A list of printers in our printer farm will appear. Only printers compatible for the machine type you selected upon upload will appear.

When choosing a machine, take note of the filament color; in this case, all printers have white loaded, except Arch-10 has black filament.
Select the printer of your choice by clicking the radio button at the right of the machine...
...with your printer now selected, click “Queue”.

Note: The “Print” button will not appear for students.
A pop-up will indicate that your print has been queued to the machine.

Click the "Go to Printers" link in the pop-up, or click on "Printers" at the top of the page to view the printer list.
This page shows the progress and queue of all machines in the Digital Fabrication Lab printer farm.

The print that was just submitted to “Arch-09” now shows as first in queue for that machine.
Once the print is started by lab staff, you can check this website to track the progress of your print.

Select printers may also have camera access so you can check on your print in real time (printers with working cameras will have a green camera button).
Lab staff will start the print, usually within 1 hour of submission, between operational hours (9am - 10pm in the Fall/Spring).

Prints submitted at closing and after hours will be reviewed the following business day.

You will receive an automatic email notification when your print has:
- Queued
- Started
- Stopped/Paused
- Finished

---

Your Object Is in Queue To Be Printed!

Dear Rachel,

Your 3D object **CCR20_house2_part2.gcode** is in queue to be printed on ARCH-09.

If you have your camera enabled and pointed at the printer you will receive a Video via email when the print is done.

Regards,

3DPrinterOS Team

[3DPrinterOS Cloud]
<table>
<thead>
<tr>
<th>Order ID</th>
<th>Name</th>
<th>Status</th>
<th>Material</th>
<th>Print Time</th>
<th>Weight (g)</th>
<th>Temperature</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCR20_Study_Model_T</td>
<td>58.13h</td>
<td>20h ago by user</td>
<td>PLA - 0.4mm</td>
<td>7.85</td>
<td>523.48g</td>
<td>210.12 °C</td>
</tr>
<tr>
<td>ARCH-08</td>
<td>Creality Endor-3</td>
<td>70.91g</td>
<td>PLA - 0.4mm</td>
<td>10m ago by me</td>
<td>8.84</td>
<td>56.17g</td>
</tr>
<tr>
<td>ARCH-09</td>
<td>Creality Endor-3</td>
<td>394.85g</td>
<td>PLA - 0.4mm</td>
<td>10m ago by me</td>
<td>8.84</td>
<td>56.17g</td>
</tr>
<tr>
<td>ARCH-10</td>
<td>Creality Endor-3</td>
<td>6.85g</td>
<td>PLA - 0.4mm</td>
<td>10m ago by me</td>
<td>8.84</td>
<td>56.17g</td>
</tr>
<tr>
<td>Arch-U01</td>
<td>Ultimaker S3</td>
<td>PLA - 0.4mm</td>
<td>PVA - 0.4mm</td>
<td>10m ago by me</td>
<td>8.84</td>
<td>56.17g</td>
</tr>
<tr>
<td>Arch-U02</td>
<td>Ultimaker S3</td>
<td>PLA - 0.4mm</td>
<td>PVA - 0.4mm</td>
<td>10m ago by me</td>
<td>8.84</td>
<td>56.17g</td>
</tr>
<tr>
<td>Arch-U03</td>
<td>Ultimaker S3</td>
<td>PLA - 0.4mm</td>
<td>PVA - 0.4mm</td>
<td>10m ago by me</td>
<td>8.84</td>
<td>56.17g</td>
</tr>
</tbody>
</table>

To CANCEL your ongoing or queued print job, click the “Cancel” button.
A confirmation window will pop-up, click “Cancel job” to confirm.
You can leave your reasoning for cancellation in the following window, then submit by clicking “Ok”.

Prints cancelled late in the job may not issue refunds as a majority of the resources have already been spent. Always double-check your work and confirm your project needs prior to submitting a job.